
    
 

CAUTION
The use of monitoring, recording, or listening devices to eavesdrop, monitor, 

retrieve, or record telephone conversation or other sound activities, whether or 
not contemporaneous with transmission, may be illegal in certain circumstances 
under federal or state laws. Legal advice should be sought prior to implementing 
any practice that monitors or records any telephone conversation. Some federal 
and state laws require some form of notification to all parties to a telephone con-

versation, such as using a beep tone or other notification methods or requiring the 
consent of all parties to the telephone conversation, prior to monitoring or record-

ing the telephone conversation. Some of these laws incorporate strict penalties.
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Introduction

Welcome!

Player Options Overview
There are two options for playing back calls recorded by your VSR(s). The first is the Desktop Player which is 
designed to be used by an individual user to play back their own archive of calls or to play back NEC Dterm VSR 
calls stored on their PC or network. It is designed to easily manage calls from one storage location. It does not offer 
many of the advanced functions of the VSR Manager, such as establishing preset shortcuts to any number of storage 
folders for quick and easy access. 

The second player option is the VSR Manager. Take your call recording environment to the next level with NEC’s 
VSR application software. VSR Manager provides advanced visibility, access, retrieval, and playback tools for the 
VSR Recorder administrators. It provides an intuitive interface for establishing shortcuts to any number of storage 
folders and allows the supervisor to search across all storage folders for specific call information such as User, Time/
Date, Length of Call, etc.  The application can be used to access and manage VSR recordings whether created by the 
single port VSR or the 4-Port Digital Call Logging Unit. VSR Manager is built on the robust Microsoft .net frame-
work and designed to manipulate large volumes of recordings. It's a workhorse that delivers truly feature rich produc-
tivity tools in a familiar, ergonomic and easy to use MS Office style interface.

VSR Manager is designed to provide the manager or supervisor the ability to quickly and easily gain access to 
important calls.  
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These two players can be combined in any number of configurations within the company, providing control and man-
agement where needed and simple playback in other locations. 

Refer to the documentation included with the Dterm VSR (P/N 780275) for details on setting up and using the 
Desktop Player.

This guide describes the installation procedures for the VSR Manager 1.x and 2.x software. It is designed to assist 
you with the installation of the software and help you to get started using VSR Manager. For detailed assistance with 
the software, please refer to the Help Files located in the VSR Manager program. 

The VSR Manager 2.x is described on page 3, while the VSR Manager 1.x information begins on page 23.
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VSR Manager 2.x

Installation and Reference Guide 

Hardware and Software Check for VSR Manager 2.x

Minimum Hardware Requirements:
● Processor: Pentium III-class (K7) 1.0GHz or equivalent (recommend Pentium 4 or equivalent) 
● Memory: 128MB (recommend 256MB+) 
● Disk Space: 30MB (recommend 60MB+) 

Minimum Software Requirements:
● Operating Systems: 

o Windows XP (recommended latest service pack) 
o Windows 2000 (recommended latest service pack) 
o Windows 2003 

● Microsoft .Net Framework 1.1+ 

Screen Resolution
VSR Manager is a visual application environment featuring dynamic graphical elements which may function at lower 
resolutions. However, for best performance and to view these items correctly, it’s recommended that you set the 
screen resolution to a minimum of 1024x768. You can do this from the Control Panel > Display Settings > 
Advanced Settings tab.

Is the Microsoft .Net Framework 1.1 installed?
VSR Manager 2.x requires the Microsoft .Net Framework, which should be installed on your PC prior to installing 
VSR Manager. If your Windows operating system has been kept up to date with Windows Service Packs, it’s likely 
the Microsoft .Net Framework 1.1 has already been installed. 

To check if you have the Microsoft .Net Framework Installed:
1. Navigate to Control Panel > Add and Remove Programs.
2. Look for an entry referencing the Microsoft .Net Framework 1.1 or later.
3. If the Microsoft .Net Framework 1.1 is not installed, you can download it from the Microsoft web site. 

Link to Microsoft .Net Framework download at time of this writing:
http://www.microsoft.com/downloads/details.aspx?FamilyID=262d25e3-f589-4842-8157-
034d1e7cf3a3&displaylang=en

 

Important Note 

If your PC does not meet the above requirements, please contact NEC. VSR 
Manager 1.x can be provided if upgrading to the minimum requirements is not 

possible or desirable. 

Not sure if .Net is Installed?

If you have any doubts, try to install VSR Manager 2.x. The installation will halt and will inform you if the 
Microsoft .Net Framework 1.1 is not found. If this occurs, you can download the Microsoft .Net Framework 

1.1, install it, restart your computer and then proceed to install VSR Manager.
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Install Your Application Security Key
VSR Manager requires an Application Security Key (a USB dongle which is shipped 
with the application) to be inserted when VSR Manager is running. This will unlock the 
application and prevent unauthorized use. VSR Manager will display messages and halt 
its processes if the Application Security Key is not found or if the wrong key is inserted.

1. Insert USB key into an available USB port on PC. 
2. Windows should respond with ‘Found New Hardware’ and identify the device as a Matrix USB Key. 
3. If Windows does not find the needed driver, browse to the CD. The driver is loaded on the CD in the 

Drivers folder.

 Important Note 

• The Application Security Key is associated with your Software license. 

• The Application Security Key is non-transferable and will not be replaced if lost. 

• If the key becomes damaged within the warranty period, you will need to return your key to sup-
port for verification and replacement if the nature of the damage qualifies. 

Please contact support or your reseller if you have any questions or if you need further information. 
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Installing and Registering VSR Manager 2.x 

Do I Need Administrator Privileges to Install VSR Manager? 
In a multi-user operating systems, such as Windows 2000 or Windows XP, applications are generally installed in a 
folder from which it can be run by all users, such as C:\Program Files. You can only install or uninstall applications if 
you have administrative privileges on your computer. If you encounter any installation problems, check to make sure 
you have administrative privileges or ask your administrator to install VSR Manager for you. 

Follow These Steps to Install VSR Manager: 
1. Insert the VSR Manager CD into the computer’s CD-ROM drive or navigate to the location where you have 

saved your application download. 
2. Double-click the VSR Manager Set-up icon. 
3. Follow the on-screen instructions. 
4. If prompted, restart your computer. 

Why Should I Register?
To get additional support, it’s a good idea to register your copy of VSR Manager. When you register, you can sign up 
for timely EMail notices about product updates so you can keep VSR Manager running at peak performance and ben-
efit from any new features and enhancements. You can also sign up to receive up-to-the-minute notices about 
upgrades and new VSR products. 

To register VSR Manager: 
1. Select Help > Online registration (your internet connection needs to be active to connect to the web site). 
2. Fill out the online electronic form. 
3. You will automatically receive a confirmation EMail and information as soon as it’s available based on your 

notification preferences. 
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Using VSR Manager 2.x 

 About the VSR Manager Workspaces
VSR Manager provides an all-in-one integrated workspace which is known as MDI (Multiple Document Interfaces). 
In this integrated workspace, all windows and panels are integrated into a single larger application window.

The VSR Manager interface is organized into 3 distinct workspace panels and windows which can be resized, mini-
mized or undocked to create a larger workspace for the task you need to perform.

Access Panel – This provides controls to retrieve recordings.

Recordings List(s) – These are document windows that display the retrieved recordings and provide 
data and file controls and tools to work with them.

 VSR Player Panel – This controls recordings playback.

1

2

3

1 2

3
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Main Window Menu Controls 
The Main Window provides controls for playback, navigation and customization. The chart below provides a quick 
reference to these: 
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Using and Creating Recordings Lists
The core of the VSR Manager is the Recordings Lists. It’s a highly versatile and customizable document window that 
displays detailed information about recordings in a tabular view with each recording presented on a row. Recordings 
Lists provide a catalog interface to recordings with in-place editing as well as single and multi-select basic functions 
like; playback, EMail and export to or from wav formats, copy to directory and delete. 

Multiple Recordings Lists can be compiled, toggled, worked with simultaneously, and with controls like drag & drop 
between Recordings Lists as well as cut, paste, merge, trim and save. You can quickly compile and save a custom 
Recordings List which is an extremely productive way to quickly access a group of recordings for reference or analy-
sis. Where recordings are stored centrally (ex. on a server), Recordings Lists can be shared, and provide an excellent 
method of training and collaboration within your call recording environment. 
 

Workflow Process 
VSR Manager workflow processes are a simple 1-2-3 logical procedure that starts with first Selecting the Record-
ings List, then Defining and Compiling the list, and finally Performing the Desired Task with the set of calls 
selected. 

1. Selecting Recordings Sources
A recordings source can be any drive or directory which is accessible from your computer. It can be defined by selec-
tion from the Explorer directory tree, a shortcut or shortcut group from the shortcuts tree. Simply select and double- 
click to start the Recordings List compilation. 
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2. Compiling Recordings Lists 
Prior to compiling a Recordings List, 
the Create Recordings List dialog 
window appears to provide list refine-
ment options. Additional folders can be 
selected and the user can choose to 
include or exclude sub-directories and 
pre-filtering options to compile a more 
targeted list. 

Pre-filtering options include file for-
mats, preset or user defined date ranges 
as well as file size/length limitations. 
When executed, each source is scanned 
for recordings - the progress is dis-
played to show the number of record-
ings found which meet the defined 
criteria. When complete, the Record-
ings List appears in a new document 
window.

Recordings lists can also be compiled 
from a saved Recordings List or a short-
cut group which directly displays the 
specified recordings omitting those 
which have been moved or deleted.

3. Perform Tasks 
With a Recordings List in view, menus, toolbars and keyboard shortcuts provide tools to perform tasks such as search, 
playback, build and save a custom list, copy or delete recordings, export to wav format, edit data, EMail and more. 
VSR Manager Instructions ◆ 9
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Getting Started 
This section describes how to compile, save and share a Recordings List as well as organize your workspace. 

To view and work with Recordings, a Recordings List must first be compiled. This can be done by navigating to a 
recordings source from the Explorer directory tree or by creating shortcuts which can access recordings source(s) in a 
single click. Methods to compile Recordings Lists and create shortcuts are described below. 

Recordings Lists are document windows which can be saved as documents and opened to retrieve the recordings they 
reference. Recordings Lists can be customized by trimming or adding additional recordings resulting in a highly tar-
geted list. A saved Recordings Lists can be utilized for many productive purposes like analysis, evaluation, training, 
archiving and collaboration. These benefits are further enhanced by sharing Recordings Lists with other VSR Man-
ager or VSR administrator application users, if recordings are stored in a central location like a server. 

Creating and Organizing Shortcuts

About Shortcuts and Shortcut Groups
Shortcuts are used to pull up a specific Recordings List from a pre-defined source. 
The shortcuts appear in the Shortcuts directory tree which can be accessed from 
the Access Panel shortcuts button.

The Shortcuts directory tree is a virtual directory tree which contains Shortcut 
Groups (folders which contain shortcuts) and Shortcuts (items inside a shortcut 
group which reference a specific directory or resource you have defined). A short-
cut group is useful to organize shortcuts by related categories like departments, 
groups of users or archive periods like months or years. By organizing shortcuts 
into shortcut groups and sub-groups, a highly defined hierarchy structure can be 
created for a detailed categorization of recordings sources.

When a shortcut is selected to compile a Recordings List, recordings in the 
recordings source referenced only by that shortcut are retrieved. When a shortcut 
group is selected to compile a Recordings List, recordings are retrieved from the 
recording sources referenced by all shortcuts contained in the shortcut group. By 
compiling a recordings list from a shortcut group, you can create a single view of 
all recordings; by department, multiple users or in multiple archiving periods.
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Creating Shortcuts from Explorer Panel 
1. Access Panel - Click the Explorer button to display the 

Explorer directory tree and navigate to a recordings source you 
would like to shortcut. 

2. Right-click on the folder and Select Add to Shortcuts option 
3. Shortcuts Panel – The new shortcut will now appear in the root of the Shortcuts directory tree defaulted 

with the name of the recordings source it references. 

Creating Shortcuts from Shortcuts Panel 
1. Access panel - Click the Shortcuts button to display 

the Shortcuts panel. 
2. Shortcuts Panel - From the Toolbar or the Context 

Menu, click the New Shortcut option. 
3. Select Directory – Use the Browse button to navigate 

to the recordings source you would like to shortcut.
4. Select Source – Select the source and click OK to con-

firm, then OK again to create a shortcut to this record-
ings source. Click Cancel to start over or abort. 

Creating Shortcut Groups 
5. Shortcuts Toolbar – From the Toolbar, select New 

Shortcut Group. This option is also available from the 
Shortcuts Context menu. 

Renaming Shortcuts and Shortcut Groups 
1. Select – Select the Shortcut or Shortcut Group. 
2. Context Menu – Right-click to bring up the Context menu and select Rename option. 
3. Enter Name – Type the new name of the Shortcut or Shortcut Group. 
4. Double-Click – Double-click to save. 

Organizing Shortcuts and Shortcut Groups 
1. Select – Select the Shortcut or Shortcut Group. 
2. Drag & Drop – Drag the Shortcut or Shortcut Group into the target Shortcut Group and release. 
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Creating and Compiling Recordings Lists 
Recordings Lists are compiled by selecting a recordings source. This can be any directory or resource accessible from 
your computer which contains recordings you would like to retrieve. Recordings sources can be accessed from the 
Explorer directory tree or Shortcuts directory tree if your shortcuts have been created. 

How to Create a Recordings List from the Explorer Panel
1. Access Panel - Click the 

Explorer button to display the 
Explorer directory tree and 
navigate to a source which 
contains recordings with 
which you would like to work.

2. Select – Select the recordings 
source and double-click.

3. Create Recordings List 
Window - The Create 
Recordings List window 
will appear with options to 
enhance your compilation.

4. Include Sub-directories – 
This option is checked by 
default to retrieve recordings 
contained in the source and 
source sub-directories. To 
limit the compilation to only 
the source directory, uncheck 
this option.

5. Compile or Apply 
Advanced Options - You 
can click the Compile button 
to begin the compilation or 
click the Show Advanced 
Options button to utilize 
advanced options for a more 
targeted list.

6. Add or Remove Sources – This option can be used to add additional recordings sources or remove them 
as required.

7. Limit by Date Range – By default, this option is set to “All Dates”. Date range pre-filters can be used to 
exclude unwanted recordings based on a date range selection.

8. Limit by File Size/Length – By default, this option is set to “All Files”. The file sizes/call length pre-fil-
ters can be used to retrieve only recordings which are larger or longer than a file size or duration you specify. 
Conversion labels will appear to calculate the approximate call length based on the defined file size. 

9. Compile or Cancel - You can click “Compile” to create a recordings list based on the filters you have 
defined or abort by clicking “Cancel”.
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How to Create a Recordings List from a Shortcuts or Shortcut Group
1. Select – Select the Shortcut or Shortcut Group and double-click. 
2. Create Recordings List Window - The Create Recordings List window will appear with options to 

enhance your compilation. 
3. Advanced Options – Follow the steps outlined in the above example from step 4 to utilize advanced 

options.

Compilation Progress Window
The compilation process starts when you click “Compile” from the Create Recordings List window. A Progress 
window will appear which displays a progress bar and messages to show the number of recordings scanned and the 
number found files found.

When the scan progress is complete, the Recordings List will appear in a new document window. You are now 
ready to work with these recordings.

Compilation Progress Window Does Not Appear?
Prior to displaying the progress window, VSR Manager builds an index of directories, sub-directories and files. You 
may experience delays or long periods of inactivity if a recordings source contains a large number of files or you have 
included a number of sub-directories in your search. This delay can vary with the number of recordings, the number 
of directories and sub-directories, the hardware capabilities and other processes which may be running simulta-
neously with VSR Manager and consuming available resources.
 

Recommendations to Improve Compilation Results

 

• To retrieve a more targeted list of recordings, it’s recommended you organize recordings in 
directories. 

• When selecting a recordings source, it’s recommended you select the parent directory of the 
recordings rather than the drive or the parent directory of the recordings directories. 

• For example, if the recordings you want to retrieve are stored in a directory called “Archive 
Jan 2005” which is a sub-directory of “My Recordings” stored on the C drive, the example 
below shows best practice to define the source:

Fast:   “C:\My Recordings\ Archive Jan 2007\”
Slow:  “C:\My Recordings\”
Not recommended:  “C:\”

Using the Include or Exclude Sub-directories option from the Create Recordings List 
window can significantly improve the compilation times as well as omit recordings which may 
not be of interest. 
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Saving and Sharing Recording Lists
Recordings Lists can be saved and used in order to quickly recall a subset of recordings, like those for a particular cli-
ent, user or related to specific classification like “verbal agreements” or “authorizations” etc. A Recordings List is a 
document which contains file path and name information for each recording and has a .reclist file extension. It can 
only be interpreted by VSR Manager or other VSR Administrative applications.

Create Directories to Save Recordings Lists
It’s recommended you create a directory called “Recordings Lists” in a location which is easy to find when needed. 
Save Recordings Lists to this directory or create further sub-directories to categorize saved Recordings Lists. 

How to Save a Recordings List
1. Main Menu - Once you are ready to save your recordings list, choose the save option from Main Menu > 

File > Save. 
2. Name and Save – Enter the descriptive name for the Recordings List as required – this name will appear in 

the header of the recording list when it is open for easy identification. 

Can I Share My VSR Manager Application Files?
Sharing Recordings Lists provides a highly effective and efficient method for collaboration, strategy meetings or 
training exercises. Recordings Lists can only be shared if recordings are stored in a central location and the path to the 
recordings is the same for all users who wish to share the Recordings Lists.

Recordings Lists files rely on absolute full path and file name information; this means that where these references are 
the same between users, sharing will reference the same files as in the example below. 
 
Can be shared: \\server\RecordingsFolder\RecordingSubfolder\filename.xtr 
Cannot be shared: C:\RecordingsFolder\RecordingSubfolder\filename.xtr 
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Copy Recordings to Another Folder
The Explorer Panel can be a quick and easy way to copy recordings to directories and delete unwanted recordings.

1. Recordings List – Create a Recordings List which contains the recordings you would like to copy. 
2. Explorer - Navigate to the target directory in the Explorer directory tree where recordings will be copied. 
3. Recordings List - Select and drag the recordings to copy into the target directory in the Explorer tree and 

drop. 
4. Confirmation Dialog - A confirmation dialog will appear. Click OK to copy the files or Cancel to abort. 
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Hotlists
The Hotlists panel is a virtual directory tree control which can be used to store links to recordings; much like Favor-
ites or Bookmarks in your browser store links you define to web sites. These links are organized into groups called a 
Hotlist. Hotlists provide a method for instant access and playback to recording(s).

Hotlists Panel Interface and Controls
● Toolbar - The Toolbar provides buttons and menu 

controls to access the Hotlists panel functions. The 
Toolbar is located at the top of the Hotlists panel.

● Directory Tree – The Hotlists tree is a virtual file 
tree of links to recordings you have defined.

o Recording Link – A Recording Link is a 
shortcut or link to open the recording which 
is represented by a file icon in the Hotlist 
tree.

o Hotlist – A Hotlist can be used to organize 
recordings links and create a single Record-
ings List of all recordings contained in the 
Hotlist(s). A Hotlist is represented by a red 
folder inside the Hotlists tree.

o Item Count – The number of recordings 
linked appears in parenthesis after the Hot-
lists name.

o Expand Node - Click the ‘+’ image next to 
the Hotlists to expand the node and display 
the recording link it contains.

o Collapse Node - Click the node ‘-’ image 
next to the Hotlists to collapse the node and 
only display the parent Hotlists.

o Refresh Node – To refresh the contents of the Hotlists, collapse and expand the Hotlists again to 
update.

● Drag & Drop
o From Hotlists - You can drag a Hotlist to any Recordings List to add all recordings in that Hot-

list to the Recordings List.
o From Recording Link - You can drag a recording to any Recordings List to add the recording to 

the Recordings List.
o Into Hotlist - You can drag Recording Links or Hotlists into other Hotlists.
o From Recordings List – You can drag recordings from the Recordings List into a Hotlist to link 

those recordings.
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How to Create and Rename a Hotlist
1. Hotlist Panel – From the Hotlist toolbar or context menu, click 

the New Hotlist option. 
2. Select – The new Hotlist will appear with the name “New Hot-

list” in the Hotlist root directory. Select the new Hotlist. 
3. Rename – From the toolbar or context menu, click the Rename 

Hotlist option and enter the new name and double-click. 

Add Recordings to Hotlist
Recording(s) can be adding to a Hotlist from the Recordings List or the 
Player using the following methods: 

From Recordings List Using Add to Hotlists…
1. Select – Select the recording(s) in the Recordings List which 

you would like to add to a Hotlist.
2. Main Toolbar – Click the Add to Hotlists button in the main 

toolbar. The Hotlist tree will appear inside a menu control.
3. Select Hotlist – Navigate to the Hotlist where the selected 

recording(s) will be linked and double-click to add.
4. Check Hotlist – The newly added recording(s) should now 

appear as links in the selected Hotlist.

From Recordings List Using Drag & Drop
1. Select – Select the recording(s) in the

Recordings List which you would like
to add to a Hotlist. 

2. Drag – Drag the selected recordings
over the target Hotlist in the Hotlist
tree folder. 

3. Drop - Drop the selection into the 
target Hotlist. 

4. Check Hotlist – The newly added
recording(s) should now appear as
links in the selected Hotlist. 
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From the Player Using Add to Hotlists… 
1. Player Toolbar – Click the Add to Hotlists button in the Player toolbar. The Hotlist tree will appear inside 

a menu control.
2. Select Hotlist – Navigate to the Hotlist where the recording in the player will be linked and double-click to 

add.
3. Check Hotlist – The newly added recording should now appear as links in the selected Hotlist.

Manage Hotlist Links

Remove Duplicates – This option can be used to remove duplicate linked recordings inside a 
Hotlist. Use the “Remove Duplicates” option from the toolbar Tools menu or context menu. 

Validate Hotlists – This option can be used to maintain the Hotlist when recording may have 
been moved, deleted or renamed; this prevents invalid links in the Hotlists. Validate Hotlist will 
check the links of all recordings in the Hotlists and remove linked recordings which have 
invalid references. Use the Validate Hotlist option from the toolbar Tools menu. 
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Player

Playback Recordings
The VSR Manager Player utilizes streaming technology for on-the-fly decompression and handles all playback and 
audio controls. The Player is located inside the Player panel which is a dynamic window that can be retracted or 
undocked to freely float about the screen. The Player panel is located at the bottom of the Main Window. 
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Player Interface and Controls

● Header
o File Name - When a recording is loaded into the Player, the file name of the recording appears in 

the Header to the far left.
o Unlocking and Undocking – By default, the player is locked into position and docked at the 

bottom of the Main Window. It can be unlocked by clicking the Locking Pin to far right in the 
Header, enabling the Player Panel to hide from view and reappear on mouse over. The Player 
Panel can also be undocked from its position to float freely about the screen using the mouse to 
drag it or by double-clicking in the Header.

● Toolbar – The Toolbar provides access to file, data and audio controls in the Player. The Toolbar 
appears below the Header. Detailed information about the Toolbar is described on page 21.

● Display – The large black area in the center of the Player is referred to as the Display. When a record-
ing is loaded into the Player, the recording information is displayed with In-Place Editing controls. 
During playback, the display shows a real time audio visualization of the conversation.

● Control Bar – The Control Bar is the area at the bottom of the Player panel which provides the basic 
Player controls like Play, Stop and Trackbar to control the Playback position in the recording. The 
Trackbar is a slide control which provides a rewind or forward function.

● Vertical Resize - The Player can be resized vertically by dragging the mouse from the top of the 
header.
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Player Toolbar 
What Controls are Available in Player Toolbar?

Player Toolbar

Control Description

Important Flag
Mark Important Flags the recording as Important.

Unmark Important Removes the Important flag.

Email
Email XTR Launches the default EMail application Send form and 

creates an attachment of the recording in XTR format.

Email WAV Launches the default EMail application Send form and 
creates an attachment of the recording in WAV format.

Convert to Format
Launches the Convert Recordings window to select format 
and convert file.

Delete Permanently deletes of the recording in the Player.

Previous Recording Loads the next recording in the Recordings List into the 
Player.

Next Recording Loads the previous recording in the Recordings List into 
the Player.

Volume Control Displays the Volume Control in the Control Bar.

Add Hotlist Displays the Hotlist tree in a Menu Control to add the 
recording in the Player to the selected Hotlist.

Play History

Double-Click Starts playback of the selected recording.

Right-
Click 
Menu

Play Starts playback of the selected recording.

Remove Removes the selected recording(s) from the Play History 
List.

Clear Clears the Play History List.

Show and 
Hide

Wave Displays the Wave Form visualization.

Editors Displays or hides (default) the Editor Control for Caller ID 
and Comments fields.

Eject Ejects the current recording in the Player and releases file 
locks.
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VSR Manager 1.x

Dterm VSR Manager 1.x Installation
The Dterm VSR Manager can be installed either on a central network location or directly to a local PC. Note that 
when using the central network location, each user still requires licensed software as well as a USB dongle which 
provides the software key.

Dterm VSR Manager Network Installation
Shortcuts are used to provide a path to the network locations which are used to store each user’s VSR calls.

The advantage of installing the Dterm VSR Manager on a network server is that only one list of shortcuts needs to be 
maintained. For example, when a member of the staff changes, you only need to make the change once, rather than on 
each supervisor’s PC. This can be beneficial when staff is replaced or extension numbers change. In the case where 
each supervisor only resides over a small number of users, then desktop installation may be desired. 

1. From the Dterm VSR Manager CD, run the “Setup.exe”file. Run the install wizard for the Dterm VSR 
Manager and select an installation location either on your server or on your local PC when prompted. 

2. Once the installation process has completed, make sure the users have access to the folder by allowing read 
access permission in the folder’s security setting (for network folders) or by sharing the local folder.

Network Installation:
Locate the VSR Manager folder on the network and right-click on the folder. Select the PROPER-
TIES menu item and set the folder permissions. Ideally, set the permission for the folder as read-
only. This will prevent your users from editing the configuration settings in the shortcut list.

Local Installation:
Run Windows Explorer (usually, by clicking START-PROGRAMS-ACCESSORIES-WINDOWS 
EXPLORER). Locate the VSR Manager folder and right-click on the folder (unless changed during 
the installation, the folder will be located under Program Files/NEC/Dterm VSR Manager.). 
Select the SHARING AND SECURITY option. Under the SHARING tab, select the SHARE THIS 
FOLDER bullet and set the folder permissions. Ideally, share the folder read-only. This will prevent 
your users from editing the configuration settings in the shortcut list. 

3. You can now run the Dterm VSR Manager from the server PC (or one that has write access to the folder) and 
edit the shortcuts (refer to Adding Shortcuts on page 1-26). Make sure you use the full network path to all 
shortcuts (e.g. \\Server\Calls\Ext100, rather than C:\Calls\Ext100). This allows all the clients on the net-
work to be able to access the files via this path. 

4. All future edits can be made on the server only and will be picked up by all Dterm VSR Manager users the 
next time they run the program. This makes it simple to maintain a large list of recorded extensions. 

5. To open the application, each client should use Windows Explorer to browse to the newly shared Dterm 
VSR Manager folder and double-click on the Dterm VSR Manager.EXE file. 

Each user can create a shortcut to this file by right-clicking on this file, then selecting Create 
Shortcut. The user can then drag this shortcut to their desktop for easy access.
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Dterm VSR Manager Desktop Installation
The Dterm VSR Manager can also be installed simply at the client level. In this case each user will need to maintain 
their own shortcuts list. This may be preferable if you have a heavily loaded network and use generic shortcuts, such 
as “Extension 100”, rather than “John Doe”. 

Hint: Copying the shortcut.ini file (located in the Dterm VSR Manager folder) can be quicker 
than editing the shortcuts list.

To install as a client application, simply click on the Setup.exe (application) icon on the provided CD and select a 
destination on the local PC.

Install Your Application Security Key
In both cases, whether installed on a network PC or on a local client, a USB key/dongle is needed to activate 
the software license. EACH USER requires a key. 

Dterm VSR Manager is USB key protected. You will require a key for each station that needs to replay calls using the 
Dterm VSR Manager. If your server is only used for administration, it can run without a Dterm VSR Manager key.

The software will function without the key installed, but you will be limited to 30 seconds of playback for each call. 
Each key contains the software key needed to run the application without any limits.

To install the key:
1. Insert the Dterm VSR Manager CD.
2. Insert the key into an available USB port.
3. Windows will respond with a “Found new hardware” pop-up window.
4. Direct the installation wizard to the CD’s MatrixLock folder.

Your Dterm VSR Manager software will now be fully operational. Note that if the USB key is removed, the software 
will revert to playing only 30 seconds of a call. Each PC requires a key.
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Dterm VSR Manager Player Software Set Up

 
The Dterm VSR Manager Player allows the user to search for calls, play back calls, mark calls as important, add 
comments to the call record, and quickly copy important calls to a separate directory for personal archiving. 

Open the Application
1. Local Installation:

Double-click the Dterm VSR Manager shortcut icon located on your desktop.

OR

1. Network Installation:
Use Windows Explorer to browse to the shared Dterm VSR Manager folder and double-click on the Dterm 
VSR Manager.EXE file. 
OR
If a shortcut was created for the user, double-click the Dterm VSR Manager shortcut icon located on your 
desktop.
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Adding Shortcuts
Shortcuts are used to speed the process of moving from folder to folder. This provides one-click access to each user’s 
call archive. 

To set up shortcuts: 
1. Click on Setup. 
2. Click on Shortcuts.

3. Select Add.
4. Enter the description for the shortcut and browse to the required location, then click OK.

5. Create as many shortcuts as necessary. 
Keep in mind they will appear in the order you enter them, so enter them in the order desired or 

you can highlight an item and click the Move Up or Move Down buttons to rearrange the order.

When entering shortcuts, enter them as the full network location (e.g. \\server\calls\…  
rather than C:\calls\… )  -  even if you are entering them on a local machine. Then, when you 
want to install it on another PC, you can copy/paste the shortcut.ini file (located in the Dterm 
VSR Manager folder), rather than having to enter all the shortcuts again.

 

EMailing or Converting Files to .wav
Simply select the file you would like to convert or EMail, then select the File tab as shown below: 

You can select to export as a WAV file or you can EMail as a WAV or “native” file (XTR file extension). Keep in 
mind, if the file is EMailed as “native”, the remote user will need the desktop player. The desktop player can be down-
loaded free of charge from www.usbcallrecord.com/downloads/bin/xtrplayer.zip.
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Search Functions
Select View then Search. This will display the search function options as displayed below.

You can search for calls by caller ID, number dialed (if provided) or by notes taken about the call during prior play-
back. Calls can be searched within all folders or only specific folders and within specific date ranges. 
 

Personal Storage Vault
The “Vault” feature allows a user to create a folder to store copies of important calls that may be needed for further 
follow-up, review or immediate external archiving. 

To set up the Vault location: 
1. Click on Setup.
2. Select Options. 

3. Create the Vault storage location by clicking the Browse button and locating the destination folder.
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